Email Addresses, Spam and White Lists

Unsolicited and unwanted advertising eMails, commonly known as "spam", have become a big
problem. It's reached such proportions that most eMail services and Internet Service Providers
(ISPs) have put some sort of blocking or filtering system in place or begun relying on self-
proclaimed blacklists to tell the good guys from the bad., , We at UFAA applaud their intention
to protect you from spam, but everyone agrees that the current systems for stopping spam are far
from a perfect solution. They often block eMails that you've requested, but that fit somebody's
idea of what spam looks like. The more responsible anti-spam activists are working hard to cut
down on these "false positives", but in the mean time, you might unexpectedly find you're not
getting your UFAA Direct updates or other important information from UFAA.

Recently updated spam filtering programs at USA.NET farmersagent.com email servers has
included several spammers addresses that have assaulted the agency force with spam messaging.
HTML formatted messages were included in the update. Unfortunately UFAA Direct emails may
be treated as spam as they are HTML documents. This is likely the reason you may not have
received recent UFAA Direct communications via your name @farmersagent.com and other non-
farmers addresses.

If you do not have an alternate email address to your @farmersagent.com address please get
one. A free email address can be obtained through the following providers

Yahoo http://www.yahoo.com/

Netscape http://my.netscape.com/

MSN Hotmail http://www.msn.com/

Hotmail http://www.msn.com/defaulta.aspx

And if you are a UFAA member you can get an @ufaa.com email account -
http://www.ufaa.com/page/membership/benefits/email.htm

If you do not wish to have an alternate email address to your @faremrsagent.com please “White
List” our email addresses (directmail @ufaa.com and ufaadirect@cbnstl.com) with your
@farmersagent.com email account.

, If you are using a non-Farmers email address there is something you can do to keep your
UFAA Direct emails from falling into the false positive trap. You can fight the blacklists with a
"White List". To “White List” our email addresses (directmail @ufaa.com and
ufaadirect@cbnstl.com) simply find your email provider and/or your spam filtering program
below and follow a few simple steps to let them know that our emails should be sent to you!

Thank you for taking the time to White List UFAA Communications

Farmers

Go to your farmers email account on dashboard by clicking the envelope at the top of the main
page near the Farmers logo.,

1. From the menu on the left side under SERVICES, select WHITE LIST FILTERING.,
2. On the WHITE LIST FILTERING PAGE activate the check mark box stating Include
email addresses from my Contacts as part of my White List.,



3. Click the activate button.,

4. Now select ADDRESS BOOK from the menu on the left side of page. Then select
PERSONAL ADDRESS BOOK.,

5. At the top right of the CONTACTS page select NEW CONTACT icon. A security
warning (perhaps two) may pop up. Just select YES to continue.,

6. On the NEW CONTACT page type UFAA in the first name box and Direct in the last
name box. In the PREFERRED EMAIL box type directmail @ufaa.com,

7. Select SAVE in the upper Left corner.

Repeat for ufaadirect@cbnstl.com

AOL, If you are using AOL, you can ensure that your subscription information is delivered to
your inbox by setting your Mail Controls. Here's how:,

1. Go to Mail Controls,

2. Select the screen name we're sending your email to,

3. Click Customize mail Controls for this screen name, ,

For AOL version 8.0:, Select allow email from all AOL members, email address and domains.,
1. Click next until the save button shows up at the bottom,

2. Click save

If you haven't received an email from us yet:, Please add our "From address" to your AOL
address book:,

Click the Mail menu and select Address Book.,

Wait for the "Address Book" window to pop up, and then click the Add button.,

Wait for the "Address Card for New Contact" window to load.,

Enter directmail @ufaa.com into the "Other E-Mail" field.,

. Make directmail @ufaa.com the "Primary E-Mail" address by checking the associated
check box.,

6. Click the Save button.

Repeat for ufaadirect@cbnstl.com
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If you have already received an email from us:, If our email is in your AOL Spam Folder, please
open the email and then click the This Is Not Spam button. Next, please add our addresses into
your Address Book as described above.

COMCAST,

1. Sign into Webmail.,

2. On the left navigation menu, click Address Book.,

3. Click Add Contact.,

4. Under the General tab, in the box under the Email Address, enter directmail @ufaa.com,
5. Click the Add button.

Repeat for ufaadirect@cbnstl.com

If you have enabled Restrict Incoming Email, also do the following:,
1. Sign into Webmail.,
2. Select Preferences.,



3. Select Restrict Incoming Email. Note: If Enable Email Controls is set to Yes, then you
are restricting incoming emails.,

4. Select Allow email from addresses listed below.,

5. Enter directmail @ufaa.com, and click the Add button.

Repeat for ufaadirect@cbnstl.com

EARTHLINK,

1. Click the Address Book button to open your address book in the browser.,

2. Click the Add Contact button (if you use EarthLink 5.0 or higher, click the Add button).,
3. Type directmail @ufaa.com into the email address slot and then click OK.

Repeat for ufaadirect@cbnstl.com

GMALIL, If you haven't received a message from us yet, add our email address to your Gmail
Contacts List:,

1. Click Contacts along the left side of any Gmail page.,

2. Click Add Contact.,

3. Enter directmail @ufaa.com into the primary email address dialog box.,
4. Click Save.

Repeat for ufaadirect@cbnstl.com

, How to check if our email is in the "spam" folder:,

1. Click Spam along the left side of any Gmail page.,
2. Check-mark the box next to our newsletter.,

3. Click Not Spam button along the top.

HOTMALIL, If you are using Hotmail, add our email address to your Hotmail Safe List. Here's

how:,

1. Open your mailbox and click "Options" (upper right hand corner).,
2. Click the "Junk E-Mail Protection" link (top of page).,

3. Select the "Safe List" link (2nd from bottom).,

4. In the space provided (labeled "Type and address or domain)", enter
directmail @ufaa.com.,

5. Click "Add",

6. When you see the address you entered in the Safe List box, click OK

Repeat for ufaadirect@cbnstl.com

If you have received a message from us:,

1. If our email is in your Junk E-Mail Folder, open the email and click the Not Junk
button.,

2. Next, check to see if our email address is in your Blocked Senders list., If you see our
email address on this list, select it and click the Remove button.,

3. Finally, if you have not done so, add our email address into your Safe List as outlined
above.

YAHOO, To ensure your subscription information is delivered to your Yahoo inbox (not the
Bulk Mail or Junk Mail folder); you can instruct Yahoo to filter it to your inbox. Here's how:,



1. Open your Yahoo mailbox,

2. Click Mail Options (upper right hand corner).,

3. Click filters,

4. Next, click add filter (may also be add link),

5. In the top row, labeled From Header: make sure contains is selected in the pull-down
menu.,

6. Click in the text box next to that pull-down menu, and then enter directmail @ufaa.com.,

(Please select the email address from the list provided, if available).,

7. At the bottom, where it says Move the message to: select Inbox from the pull-down
menu.,
8. Click the Add Filter button again.

Repeat for ufaadirect@cbnstl.com

If you have received a message from us:,

1. If our email is getting stuck in your Yahoo Bulk Folder, please open, the email and click
the Not Spam button.,

2. Next, check to see if the email address is in your "Blocked Addresses" list. If you see our
email address on this list, select it and click the Remove Block button.,

3. Lastly, please set up a filter as outlined above.

MOZILLA THUNDERBIRD, If you haven't received a message from us yet:, You will

need to add our email address to your Thunderbird Address Book and configure your Junk Mail
Controls to white list your address book.,

1. Click the Address Book button.,

2. Make sure the Personal Address Book is highlighted.,

3. Click the New Card button. This will launch a New Card window that has 3 tabs:
Contact, Address & Other.,

4. Under the Contact tab enter directmail @ufaa.com into the Email dialog box.,

5. Click OK.

Repeat for ufaadirect@cbnstl.com

If you have received a message from us:,

1. Please check your Junk folder to see if our emails have been mistakenly placed there.,

2. To prevent this from happening in the future, you need to mark our email as not junk. Do
this by right-clicking on our newsletter and choose "Mark -< As Not Junk".

White list your Personal Address Book:,

1. From the main drop down menu, select "Tools -< Junk Mail Controls...", This will
launch the Junk Mail Controls window that has two tabs: Settings and Adaptive Filter.,
2. Under the Settings tab, update the "White Lists" module by selecting Personal Address

Book from the pull down menu and then check mark the box next to "Do not mark messages as
junk mail". Click OK.

ENTOURAGE 2004, Add our email address to your Safe Senders list:,
1. From the Tools menu, select Junk Email Protection.,
2. Choose the level of protection you want to apply to junk email.,



3. Click the Safe Domains tab and enter the domain name of trusted domains to exempt
messages that you receive from specific domains. Messages from domains listed here will never
be treated as junk mail.,

4. Click "ok".

OUTLOOK EXPRESS, If you have received a message from us:,

1. Open the email.,

2. Left-click the sender icon, or right-click the sender's name.,
3. Click "add to contacts".,

4. Click "save and close".

OUTLOOK 2003, Add our email address to your Safe Senders list:,
1. On the Tools menu, click Options.,

2. On the Preferences tab, click Junk E-mail.,

3. On the Safe Senders tab, click Add.,

4. In the Add address, enter directmail @ufaa.com,

5.
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Click OK.
epeat for ufaadirect@cbnstl.com

OUTLOOK 2007, Add our email address to your Safe Senders list:,

1. Click Options from the Tools Menu,

2. From the Preferences Tab, Click the "Junk Email" button,
3. Click the Safe Senders Tab,

4. Add directmail @ufaa.com to your safe senders list.

Repeat for ufaadirect@cbnstl.com

SBC GLOBAL,

1. Go to the SBC Global Mail page and click the Options link.,

2. In the Management section, click the Filters link.,

3. Click the Add button.,

4. In the "From header" rule, in the field to the right of contains, enter our
directmail @ufaa.com.,

5. From the Move the message to pull-down list, choose inbox.,

6. Click the Add Filter button to save the filter.

Repeat for ufaadirect@cbnstl.com

VERIZON,

1. Go to your account and click on the Address Book link in the left column.,
2. Select Create Contact.,

3. The Add Address Book Entry screen appears. In the Email field enter
directmail @ufaa.com.,

4. In the Nickname field, enter directmail @ufaa.com.,

5. Select Save.

Repeat for ufaadirect@cbnstl.com




Third Party Spam Control

SpamCop

If you're using SpamCop to filter your incoming e-mail, you can exempt UFAA Direct from the
filtering process by adding our "From" address to your White list. Here's how:

Open your browser and go to this page: http://webmail.spamcop.net/

Log into your SpamCop account.

Click on the Options icon in the toolbar.

Under Mail Management (in the middle), click SpamCop Tools.

Select Manage your personal white list.

Near the bottom, where it reads "Click here to add to your white list", click on Click

Enter directmail @ufaa.com in the first empty slot.
. Click Submit.
Repeat for ufaadirect@cbnstl.com
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SpamAssassin

If you're using Spam Assassin to filter your incoming e-mail, you can exempt UFAA Direct from
the filtering process by adding our "From" address to the White list in your User Preferences.
Here's how:

1. Search your hard drive for the spamassassin folder, and then open it.

2. In that folder should be a file named user_prefs. Open it with a text editor (Notepad, for
example). If there is no such file, you can create it. The detailed instructions are at
http://spamassassin.taint.org/doc/Mail SpamAssassin_Conf.html.

3. Make a new (blank) line in the file. On that line, enter whitelist_from, followed by the
address in the "From" line of your most recent Agent Inner Circle™.
4. Save the file and close it.

Repeat for ufaadirect@cbnstl.com

Spamkiller

If you're using McAfee's Spamkiller to filter your incoming e-mail, you can exempt UFAA
Direct from the filtering process by adding our "From" address to your list of Friends. Here's
how:

1. On the Spamkiller sidebar, click Friends.
2. Click Add.
3. Enter directmail @ufaa.com and click the OK button.

Repeat for ufaadirect@cbnstl.com

Mailblocks

If you're using Mailblocks to filter your incoming e-mail, you can exempt UFAA Direct from the
filtering process by adding our "From" address to your "Accept Mail From" list of addresses.
Here's how:

1. In Mailblocks, click the Addresses tab.

2. Select New.

3. Enter directmail @ufaa.com.




4. In the Receiving Options, select Accept Mail From This Address.

5. In the Other Options, make sure Display in People Picker is not selected.
6. Click Submit.

7. Click OK.

Repeat for ufaadirect@cbnstl.com

MailShield

If you're using MailShield to filter your incoming e-mail, you can exempt UFAA Direct from the
filtering process by adding our "From" address to your list of Friends. Here's how:

1. On the MailShield toolbar, click Friends.
2. Click Add.
3. Enter directmail @ufaa.com and click the OK button.

Repeat for ufaadirect@cbnstl.com

MailWasher

If you're using MailWasher to filter your incoming e-mail, you can exempt UFAA Direct from
the filtering process by adding our "From" address to your list of Friends. Here's how:

1 In MailWasher, select Tools.

2 Select Blacklist & Friends.

3. On the right-hand side is the "Friends" list. Click the Friends Add button.

4. Select Plain email address.

5 Enter directmail @ufaa.com, and then click OK.

6. Click OK again.

Repeat for ufaadirect@cbnstl.com

CleanMyMailbox

If you're using CleanMyMailbox to filter your incoming e-mail, you can exempt UFAA Direct
from the filtering process by adding our "From" address to your White list. Here's how:

1. Click the White list button.

2. Enter directmail @ufaa.com.

3. Click the Submit List button.

Repeat for ufaadirect@cbnstl.com

Spam Inspector

If you're using Spam Inspector to filter your incoming e-mail, you can exempt UFAA Direct
from the filtering process by adding our "From" address to your list of Friends. Here's how:
Open Outlook.

On the Spam Inspector menu or toolbar, find and select Manage Friends List.

In the Add a New Friend area, select E-mail.

Enter directmail @ufaa.com.

Click the >> (add) button.

. Click Close.

Repeat for ufaadirect@cbnstl.com
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Spam Interceptor



If you're using Spam Interceptor to filter your incoming e-mail, you can exempt UFAA Direct
from the filtering process by adding our "From" address to your list of Trusted senders. Here's
how:

1. Open Spam Interceptor and select Authentication Lists.
2. Click Trusted.
3. Enter directmail @ufaa.com.

4. Click Add.
Repeat for ufaadirect@cbnstl.com

Spam Sleuth

If you're using Spam Sleuth to filter your incoming e-mail, you can exempt UFAA Direct from
the filtering process by adding our "From" address to your list of Friends. Here's how:

1. Open Spam Sleuth.

2. From the File menu, select Configure.

3. In the Friends category, make sure Active is selected.

4. In the space provided for the list, make a new (blank) line and on it enter
directmail @ufaa.com

5. Click OK.

Repeat for ufaadirect@cbnstl.com

SpamButcher
If you're using Spam Butcher to filter your incoming e-mail, you can exempt UFAA Direct from
the filtering process by adding our "From" address to your Know Senders list. Here's how:

1. Open Spam Butcher and click the Configure button.

2. Select the Known Senders tab.

3. Under Known Good Senders and Recipients, click Add.
4. Enter directmail @ufaa.com and click OK.

5. Click OK.

Repeat for ufaadirect@cbnstl.com

Spameater

If you're using Spameater to filter your incoming e-mail, you can exempt UFAA Direct from the
filtering process by adding our "From" address to your list of Approved Senders. Here's how:
On the Spameater sidebar, click Filters.

Select the Approved Senders tab.

Click Add Filter.

In the Address space, Enter directmail @ufaa.com

For Address Type, select Full Email Address.

. Click OK.

Repeat for ufaadirect@cbnstl.com
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SpamNet

If you're using Cloudmark's SpamNet to filter your incoming e-mail, you can exempt UFAA
Direct from the filtering process by adding our "From" address to your White list. Here's how:
1. Open your Outlook Inbox.

2. On the Cloudmark SpamNet toolbar, click Options.



Click Advanced.

Select the White list tab.

Click the Add button.

Enter directmail @ufaa.com and click the OK button.
Click OK again, then Yes, then OK one last time.
Repeat for ufaadirect@cbnstl.com
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SpamPal
If you're using SpamPal to filter your incoming e-mail, you can exempt UFAA Direct from the
filtering process by adding our "From" address to your White list. Here's how:

1. When SpamPal is running, find the SpamPal icon in your Windows system tray and
right-click on it.

2. Select Add to White list.

3. Enter directmail @ufaa.com.

4. Click Add.
Repeat for ufaadirect@cbnstl.com

Others

Many popular e-mail programs, including older versions of Outlook, Outlook Express, Eudora,
and Netscape Mail, don't provide a convenient way for you to white-list the folks you want to
receive e-mail from. If you're using this sort of e-mail system and you either aren't getting UFAA
Direct or want to make sure you keep receiving your UFAA Direct communications you can do
something about it.

Contact the customer service people or the Postmaster at the company that provides your e-mail
or Internet connection (your ISP). Explain to them that UFAA Direct emails are emails that you
asked for and value. Ask them if they can white-list UFAA. (Unfortunately, some e-mail systems
don't allow white-listing.) If they do white-list, they'll probably ask you for some information
about us. Here's what to tell them:

1. Sending Address: If they ask for our address, give them both directmail @ufaa.com and
ufaadirect@cbnstl.com

2. Domain: If they need to know the domain we're mailing from, tell them ufaa.com and
cbnstl.com.

3. IP address: if they need the sending ip address tell them 66.84.59.111




